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Before You Begin 

Before presenting this demo, the presenter should be familiar with the basic functions 
of Office and SharePoint 2007 and Office Info Path 2007.   

This guide walks through a number of demos covering creating a new compliance 
correspondence memo content type, assigning to a document library and customising 
the Document Information Panel using Office Info Path 2007.  This guide is meant to 
give the audience a basic understanding of the breadth of the capability in the 2007 
Office System content types. 

User Account for Demos 
 

Account Password Role 

Administrator pass@word1 System Administrator 

   

General Tips and Tricks 
 

 If you’re using a laptop or Tablet PC and will be using a projector or other large display 
for your demo, test your PC’s ability to send video to an external display.  
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Customising the Document Information Panel 

Messaging Actions 

Creating a Word Template 

You might be familiar with the what Microsoft 
Office SharePoint Server 2007 is capable of 
regarding managing and collaborating on 
documents, but let’s just take a brief look. 
 

1. Open the browser and navigate to the 
top level site. Note: for demo purposes 
set the home page 

2. Create a new site using the Blank Site 
template, call the site “Team Site” 

3. In the new site, create a new 
Document Library, call the library 
“Compliance” 

4. Click the arrow icon next to New 

As you can see we are able to create a new 
document using the normal document template.  
Although this provides some functionality, we 
would like to assist the users with choosing an 
appropriate template such as a Compliance 
Correspondance Memo. 
 
So lets create a new Word template for our 
company Compliance Correspondance Memo. 

5. Launch Microsoft Word. 

6. Open the Compliance Correspondance 
template. 

7. Close Word. 

Creating Site Columns for Metadata 

One of the other important features of Microsoft 
Office SharePoint 2007 is the ability to attach 
metadata to items such as documents.  This 
metadata assists user’s to classify content and to 
locate the content in the future. 
 
For our company memo, we are going to add some 
additional metadata elements to assist users. 

8. Open the browser and navigate to the 
new Team Site 

9. Using Site Actions, select the Site 
Settings link 

10. Choose the Site columns option from 
the Gallaries menu 

We are going to create three new site columns; 
1. From; a text field to hold the name of the 

person sending the memo 
2. Memo Date; a date field to hold the date 

of the memo 
3. Audience; a text field to hold the intended 

11. Click Create 

12. Column Name: From 
Column Type: Single line of text 
Group: New Group “Company 
Columns” 
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Messaging Actions 

audience of the memo 
 

13. Click OK 

14. Click Create 

15. Column Name: Memo Date 
Column Type: Date and Time 
Group: Existing Group “Company 
Columns” 
Make this column a mandatory 
column 

16. Click OK 

17. Click Create 

18. Column Name: Audience 
Column Type: Single line of text 
Group: Existing Group “Company 
Columns” 

19. Click OK 

Creating Site Content Type 

Great now we have some new columns, but how 
do we associate them with the Document Library 
and the Word Template?  This is done by creating 
a Site Content Type. 
 
A Content Type is important to SharePoint 
because it allows you to define the metadata that 
should be recorded, the template that should be 
used for new instances and document 
management and rights management policies. 

20. Using Site Actions, select the Site 
Settings link 

21. Choose the Site content types option 
from the Gallaries menu 

22. Click Create 

23. Name: Compliance Correspondance 
Description: Leave Blank 
Parent Content Type: Choose 
Document Content Types for the first 
drop down and Document 
Group: New Group “Company Content 
Types” 

24. Click OK 

Now we have a new Company Compliance 
Correspondance Memo Content Type, we now 
need to associate the metadata site columns we 
created before. 

25. In the Columns section, click “Add 
from existing site columns” 

26. Select the “Company Columns” group 

27. Add each of the Site Columns we 
created before: 
- From 
- Memo Date 
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Messaging Actions 

- Audience 

28. Click OK 

Great, now there is one more step we need to do 
to ensure that the Content Type is complete and 
that is associate the Word template we created. 

29. In the Settings section, click the 
Advanced settings link 

30. In the Document template section, we 
are going to upload the Word 
template, browse for the .dotx file we 
created before. 

31. Click OK 

Managing Content Types in Document Libraries 

Now we have a new Content Type that has 
metadata associated and a Word template also, 
now we need to hook it up to the Compliance 
Document Library. 

32. Navigate to the Compliance document 
library 

33. Under the Settings menu, choose 
Document Library Settings 

You’ll see that we are able to maintain several 
elements of the document library, such as 
security, policies, manual columns and views. 
 
What we need to do is enable Content Type 
management on this document libary.  This is 
done under Advances settings. 

34. In the General settings section, click 
the Advanced setting link 

35. Change “Allow management of 
content types” to Yes 

36. Click OK 

You’ll see now that we have a new section in the 
Document Library Setting screen for Content 
Types. 
 
Let’s add the Company Complicance 
Coresspondance Memo content type. 

37. Choose, “Add from existing site 
content types” link 

38. Select the “Company Content Types” 
group 

39. Add the “Compliance 
Correspondance” content type 

40. Click OK 

For housekeeping, we are also going to remove 
the default “Document” content type from the 
document library. 

41. Click on the “Document” link 

42. Click on the “Delete this content type” 
link 

43. Click OK on dialog. 
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Messaging Actions 

Changing the View to show our Metadata 

Just before we see the new document template in 
action, I want to do one more thing and that is to 
change the document library view to show our 
new metadata columns. 

44. In the Views section of the Document 
Library Settings, click the “All 
Documents” link 

45. Tick the three new columns to enable 
them to be displayed 
- From 
- Memo Date 
- Audience 

46. Click OK 

You’ll now see the new metadata columns being 
displayed in the document library 

 

Let’s see the template in action 

Now lets create a new company compliance 
correspondence memo, using the new template 
and content type. 

47. Navigate to the Compliance document 
library 

48. Click the arrow icon next to New 

As you can see we now have a new template for 
the user to choose from “Compliance 
Correspondance” 

49. Click on “Compliance 
Correspondance” 

Microsoft Office Word 2007 starts and the 
Company Compliance Correspondance Memo 
template is loaded. 

50. Enter some memo text 

51. Click Save 

52. Enter the name of the memo 
“Letter1.docx” 

Notice that we have been unable to save the 
memo, this is because the Memo Date column we 
create is mandatory and we haven’t filled it in. 
 
The Document Information Panel allows a user 
while in the rich Office client of Word to associate 
the document with theappropriate metadata.  The 
metadata we defined in the content type is 
automatically provided to Word including any 
restrictions such as mandatory elements. 

53. Enter From 

54. Enter or choose a Memo Date 

55. Enter “Company” as the Audience 

56. Click Save 

57. Enter the name of the memo 
“Letter1.docx” 

58. Close Word 

Note: The browser refreshes, if not, you 
will need to refresh it. 
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Messaging Actions 

Creating a custom Document Information Panel 

Now we have provided the users with a much 
more structured idea of the content that should be 
placed in the Compliance document library as well 
as the metadata that we require of them. 
 
The Document Information Panel provides a great 
way of integrating the metadata and associated 
rules between SharePoint and Office.  The 
Document Information Panel is actually a 
Microsoft Office Info Path form and as such we are 
able to do a lot more with regards to design, web 
service integration and validation. 
 
Let’s have a look at basic customisation of the 
Document Information Panel. 

59. Using Site Actions, select the Site 
Settings link 

60. Choose the Site content types option 
from the Gallaries menu 

61. Choose the “Compliance 
Correspondance” content type link to 
get to the setting page 

62. Choose the “Document Information 
Panel settings” link 

63. Under Document Information Panel 
Template, click “Create a new custom 
template” 

This load up Microsoft Office Info Path 2007 and 
automatically creates the base Document 
Information Panel based on the defined Site 
Columns. 
 
Lets do some basic cosmetics, let’s remove the 
Title column, change the background colur and 
add a small company logo. 

64. Click on the box area around the Title 
column and press Delete 

65. Under the Format menu choose 
Background Color... 

66. Change the background colour to 
Yellow 

67. Place the cursor at the start of the 
columns, and click insert Picture Clip 
Art 

68. Search for Computer and select an 
image and resize to appropriate 
proportions. 

69. Save the form “Compliance 
Correspondance.xsn” 

70. Choose Publish from the File menu 

71. In the Publishing Wizard, choose the 
“As a Document Information Panel 
template for a SharePoint site content 
type or list content type” and click 
Next 

72. Click Publish 

73. Close Info Path 
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Messaging Actions 

74. Click the “Go back to the Document 
Information Panel settings page” link 

75. Tick the “Always show Document 
Information Panel on document open 
and initial save for this content type” 
option. 

76. Click OK 

Let’s have a look at the new Document 
Information Panel in the existing Memo. 

77. Navigate to the Compliance document 
library and click on the Letter1.docx 
document 

78. Show the new Document Information 
Panel then close Word. 

Creating a more complex custom Document Information Panel 

This is all good but my users will get sick of having 
to enter their name, the audience and the date of 
the memo, so let’s make it a bit easier for them. 
 
Microsoft Office Info Path 2007 has some really 
good productivity tool inbuilt, especially when it 
comes to setting default values. 

79. Under the Tools menu, choose Default 
Values... 

80. Using the dialog, navigate to the 
Properties for From, Memo Date 

81. Set the From field to a default value of 
dc:creator 

82. Set the Memo Date field to a default 
value of now 

83. Click OK 

We are also going to set the format of the Memo 
Date to be more readable. 

84. In the properties section, change the 
bindings format to a more acceptable 
date format. 

85. Click OK 

86. Click OK 

Another highly useful productivity capability of 
Info Path is the ability to change the control type. 
In this example we are going to change the 
Audience column from a text entry to a drop down 
list box. 

87. Right mouse click the Audience field 
and choose Change To | Drop-Down 
List Box 

88. Righy mouse click the Audience field 
and choose Drop-Down List Box 
Properties... 

89. Add three options; 
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Messaging Actions 

- Company 
- HR Dept 
- IT Dept 

90. Click OK 

We now need to save the new Document 
Information Panel and republish to the SharePoint 
environment. 

91. Save the form “Compliance 
Correspondance.xsn”, overwrite the 
existing file 

92. Choose Publish from the File menu 

93. In the Publishing Wizard, choose the 
“As a Document Information Panel 
template for a SharePoint site content 
type or list content type” and click 
Next 

94. Click Publish 

95. Close Info Path 

96. Click the “Go back to the Document 
Information Panel settings page” link 

97. Click OK 

Let’s have a look at the new Document 
Information Panel in the new Memo. 

98. Navigate to the Compliance document 
library and click on the New button 

99. Show the new Document Information 
Panel 

As you can see the users name and todays date 
have been automatically populated. Let choose 
Company from the drop down list. 

100. Choose “Company” from the 
Audience drop down list 

101. Do not save, just close Word 

 


